Table of Contents Manual

This manual provides:

1. Guidelines for how to properly format the Table of Contents.

2. Instructions on the two ways of generating a Table of Contents in Microsoft Word.

3. Table of Contents examples.

Sections:

Section 1: Formatting the Table of Contents (p.2)

Section 2: Manually create a Table of Contents in Microsoft Word (p. 4)

Section 3: Create a Table of Contents Automatically in Microsoft Word (p. 8)

Table of Contents examples (p. 11)
Section 1: Formatting the Table of Contents

- A Table of Contents (TOC) must appear in your thesis or dissertation document.

- The items that should be listed on the TOC should include all pages from the Abstract through the Curriculum Vitae. Thus, your TOC includes:
  - Abstract (starts on page iii)
  - Acknowledgements (optional)
  - Dedication (optional)
  - Preface (optional)
  - Table of Contents (optional to put it on the TOC of your thesis/dissertation)
  - List of Tables (if applicable)
  - List of Figures (if applicable)
  - Any other lists including: List of Definitions, List of Algorithms, List of Equations, etc. (if applicable)
  - Main body of your text (e.g., chapter titles, headings, subheadings)
  - Appendix or Appendices (optional)
  - Bibliography
  - Curriculum Vitae

- As the last document of your text, the Curriculum Vitae is the last item of your TOC.

- The page numbers listed on your TOC must match the page numbers of items as they appear in the text.

- The titles listed in the TOC must match the titles as they appear in the text.

- In general, your document needs to be broken down into Chapters/Sections. Chapters must appear in the TOC.

- The title must match exactly between the TOC and the text. The page number must also match exactly between the two.
  - For example, if the chapter title, “Chapter 1 Introduction: An Unexpected Beginning,” is used on page 5 of the text the Table of Contents should list:

  Chapter 1 Introduction: An Unexpected Beginning.................................5

- Chapter sections and subsections should appear consistently in the TOC. If a level of subsection is included in the TOC, then all subsections at that level must be
listed in the TOC. Subheadings and subsections are not required to be listed in your TOC.

• Creative dissertations (novellas, novels, and poetry) that do not have a chapter structure should have at least 1 major section listed in addition to their front materials and Curriculum Vitae. Collections of short stories should list the stories contained in the collection as sections in the TOC.
Section 2: Manually Creating A Table of Contents in Microsoft Word

There are two ways that you can generate a TOC in Word: typing it manually or creating it automatically. This section discusses the former.

Typing the TOC Manually:
This method involves 1) typing the entries (chapter titles, headings, and subheadings) and 2) using either tabs to get the dotted lines (ellipses) or dot leaders between each entry and its respective page number.

On the TOC page:
1. Type the first entry

2. Press Tab and then type its respective page number (remember to make sure the respective page number matches exactly between the document and what is listed in the TOC

3. Then select the Tab stop character. In order to show the Tab stop character, click the Home tab. Then click Show/Hide in the paragraph group.

4. Click the arrow found at the bottom left hand corner of the paragraph group.

5. This launches the Paragraph Dialog Box. [Alternatively, you can click the Format tab on the top, then click Paragraph. This will also launch the Paragraph Dialog Box].
6. Click the Tabs button.

7. Type 6.4” under the Tab stop position. This means that your number will end at the 1” margin (Remember all margins, including the left margin, for the thesis or dissertation must be 1”).
8. Under Alignment, click Right.

![Tabs dialog box showing Right selected]

9. Under Leader, chose option 2 for ellipses in your Table of Contents. Or, choose option 1 if the use of leaders in the text is prohibited.

![Tabs dialog box showing Leader option 2 selected]

10. Click Set and then OK.

11. Press Enter. Type your next entry, press Tab, and then type the entry’s respective page number.

12. Repeat until your Table of Contents is finished.
**Note:** Primary, secondary, tertiary, etc., levels of headings should be formatted per the rules laid out in your style guide. Your style guide will breakdown how each level of heading will appear in your text and in your Table of Contents.
Section 3: Create a Table of Contents in Microsoft Word Automatically

In order to create a TOC in Microsoft Word automatically, you need to have already applied heading styles to the major heading as well as all subheadings in your thesis or dissertation document. For help applying heading styles to these items please see the pdf Headings and Subheadings located in Section 5: Organization of the Thesis and Dissertation under Main Body of Your Text on the Graduate College Thesis and Dissertation website http://www.unlv.edu/graduatecollege/thesis. Assigning a style to each heading and subheading enables Word to track the location of these items. This then allows Word to create a list of them or a TOC.

Generating a TOC Automatically:

1. Since you will be generating the TOC from heading styles, it is important to determine that all major headings and subheadings have the heading style that you intended. All of your major headings (e.g., chapter headings, Abstract, Table of Contents, etc.) should all use the Heading 1 style, all of your primary or first-level subheadings should all use the Heading 2 style, and so on.
2. Go to your currently blank Table of Contents page in your document. If you did not save a page for the Table of Contents, then please add it now. Make sure your major heading (Table of Contents) follows the other major headings style.
3. Go to the References Tab (alternatively you can click on the Document Elements tab).
4. Click on the Table of Contents. It is located on the farthest left hand side of the References ribbon.
5. Choose “Insert Table of Contents.” The Table of Contents box appears. Click on the tab labeled “Table of Contents.” A similar image should appear.
6. Choose the Options button.
7. The menu “Table of Contents Options” appears. Here is where you can choose which headings and subheadings to include on the Table of Contents.

8. At the very minimum, Heading 1 must be on the TOC. Thus, the corresponding TOC level must be 1. The rest of the Heading styles are optional to place on the TOC, but their TOC level should correspond with the subheading level. For example, primary or first level subheadings are Heading style 2 and their TOC level is 2, secondary or second level subheadings are Heading style 3 and their TOC level is 3, and so on. If you do not want a Heading style to appear on the Table of Contents then remove the TOC level number.

9. Once you are finished, click OK. Click OK again on the Table of Contents box. This should generate your TOC on the Table of Contents page.

Note: If you see mistakes in your headings or subheadings (e.g., spacing problems, misspellings, etc.) on the Table of Contents page, do not correct the mistakes on the Table of Contents page itself. Rather, go to the heading or subheading in your document and make the necessary corrections. You will need to update the Table of Contents to reflect the changes.

Updating the Table of Contents:

1. Go back to the References tab.
2. In the Table of Contents section (farthest left-hand corner), you will see “Update Table.”
3. Select this option and your Table of Contents will be updated.
Sample Table of Contents: No Subheadings

Table of Contents

Abstract .................................................................................................................................................... iii

Acknowledgements ................................................................................................................................ iv

Dedication ........................................................................................................................................ vi

List of Tables ........................................................................................................................................ x

List of Figures .......................................................................................................................................... xi

Chapter 1: Introduction ....................................................................................................................... 1

Chapter 2: Historical Background ..................................................................................................... 14

Chapter 3: Methodology .................................................................................................................... 44

Chapter 4: Analysis ............................................................................................................................. 102

Chapter 5: Conclusion ......................................................................................................................... 139

References ........................................................................................................................................... 169

Curriculum Vitae ................................................................................................................................ 182
# Sample Table of Contents: With Subheadings

## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledgments</td>
<td>v</td>
</tr>
<tr>
<td>List of Tables</td>
<td>vii</td>
</tr>
<tr>
<td>List of Figures</td>
<td>ix</td>
</tr>
<tr>
<td>List of Equations</td>
<td>x</td>
</tr>
<tr>
<td>Chapter 1: Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Overview</td>
<td>2</td>
</tr>
<tr>
<td>Bees</td>
<td>3</td>
</tr>
<tr>
<td>Why Bees are Better than Wasps</td>
<td>3</td>
</tr>
<tr>
<td>Context of Little Black Rain Cloud Incident (1907)</td>
<td>4</td>
</tr>
<tr>
<td>American Foulbrood (AFB) disease</td>
<td>4</td>
</tr>
<tr>
<td>Current AFB disease management</td>
<td>7</td>
</tr>
<tr>
<td>Chapter 2: Bees Make Honey</td>
<td>19</td>
</tr>
<tr>
<td>Abstract</td>
<td>19</td>
</tr>
<tr>
<td>Introduction</td>
<td>20</td>
</tr>
<tr>
<td>Methods and Materials</td>
<td>22</td>
</tr>
<tr>
<td>Results</td>
<td>28</td>
</tr>
<tr>
<td>Discussion</td>
<td>31</td>
</tr>
</tbody>
</table>
Chapter 3: Low Carb Diets Limit Honey Consumption .............................................. 48
  Abstract ......................................................................................................................... 48
  Literature Review ........................................................................................................ 49
  Bees in Books ................................................................................................................ 50
  Bees in Cinema ............................................................................................................. 52
  Bees on a Plane ............................................................................................................. 55

Chapter 4: Low-Carb Diets are Killing Off Bees ......................................................... 57
  Abstract ......................................................................................................................... 57
  Introduction .................................................................................................................. 57
  Methods and Materials ............................................................................................... 59
  4.4: Results ................................................................................................................... 64
  4.5: Discussion ............................................................................................................ 68

Appendix: Random Bee Information ........................................................................... 122

References ..................................................................................................................... 132

Curriculum Vitae ......................................................................................................... 147
Sample Table of Contents: Creative Dissertation

TABLE OF CONTENTS

ABSTRACT.................................................................................................................................................. iii

ACKNOWLEDGEMENTS .......................................................................................................................... v

PREFACE .................................................................................................................................................... vi

1: THE MILLER’S WIFE .......................................................................................................................... 1

2: SALTED EARTH.................................................................................................................................... 80

CURRICULIM VITAE .................................................................................................................................. 117